Chapter 5 - Initial Geometry Procedures

Geometry describes the path that the proposed roadway will follow over the existing ground. This chapter
covers the geometry file structure for various specialty groups, geometry management concepts, and some of
the tools to view, review, and edit geometry.

Chapter Objectives:
e Review various geometry file structures.
e Examine the Style Manager.
e Discuss geometry file management.
e Describe how to set geometry active.
e Review the Copy, Rename, and Delete geometry commands.
e Describe how to display a variety of horizontal geometry items into the MicroStation file.

e Describe how to use Tracking.

Geometry Data Review

Section Objectives:

e Describe the types of data available from survey geometry.
e Describe the hierarchy within a geometry project.

e Describe the layout of typical geometry project for various specialty groups.

Geometry Data from Survey

Survey data will be used as a foundation for our initial geometry work. The survey staff exports
linear elements from the survey fieldbook as alignments and Cogo points at all survey shot
locations. This data may be used for:

e Establishing the centerline of existing roadways

e Flow-lines of existing stream or other drainage

e Locations of existing retaining walls or bridge geometry
e Locations of existing signs or utilities

e Existing pavement limits or curb and/or gutter locations

The goal is to review some of the geometry data the survey staff produces.

The Geometry Project

The geometry project, commonly referred to as the ‘ALG’ file, is the data file that stores
horizontal and vertical alignments, and cogo points (called the cogo buffer). An older geometry
file may also contain superelevation data.

The hierarchical relationship between the data stored in a geometry project is illustrated below.
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Generic Geometry Project

Geometry
Project
Horizontal Horizontal COGO
Alignment Alignment Buffer
Vertical Vertical
Alignment Alignment

Multiple geometry projects can be loaded into memory. However, only one geometry project
can be active at a given time. Within the active geometry project, a single horizontal and a
single vertical alignment can be active at any given time.

Sample Roadway Design Geometry Project

alignments and superelevation solutions.

12345Design
SR 256 Design_01 Design_02 COGO
30mph 40mph Buffer
Vertical Vertical Vertical
Option 1 Option2 Option3

A typical design geometry project may contain horizontal alignments for the mainline, side
roads, ditches, or alternative designs. Each horizontal alignment may have associated vertical
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Sample Survey Geometry Project

(Exported from a Fieldbook)

12345
Survey
13164 13182 13193 COGO
(horizontal) (horizontal) (horizontal) Buffer
13164 13182 13193
(vertical) (vertical) (vertical)

Sample Cogo Buffer Contents

2 Contral Monument-Project 1575543.55 2869374.46  11492.10
3 Contral Monument-Project 1573793.05 2846506.67 10269.52
219 Traffic Control No Pass Left Yellow 1556202.40 2843268.49 11423.11
220 Traffic Control No Pass Left Yellow 1556207.76 2843266.69 1142344
221 Traffic Control Mo Pass Left Yellow 1556218.47 2843263.03  11424.10
222 Traffic Control Mo Pass Left Yellow 1556223.82 2843261.18 11424.43
223 Traffic Control No Pass Left Yellow 1556234.49 2843257.43  11425.10
224 Traffic Control No Pass Left Yellow 1556245,14 2843253.62 1142576
225 Traffic Control Mo Pass Left Yellow 1556252.23 2843251.04 11426.20
226 Traffic Control Mo Pass Left Yellow 1556256,95 2843249,31  11426.50
227 Traffic Control No Pass Left Yellow 1556275.80 2843242.25 11427.68
228 Traffic Control No Pass Left Yellow 1556250.50 2543240.46  11427.95
229 Traffic Control Mo Pass Left Yellow 1556287.55 2843237.74  11428.43
230 Traffic Control Mo Pass Left Yellow 1556298,10 284323361  11429.10
231  Traffic Control No Pass Left Yellow 1556308.63 2843229.42 11429.77
232 Traffic Control No Pass Left Yellow 1556313.58 2843227.30  11430.11
233 Traffic Control Mo Pass Left Yellow 155632437 2843223.02  11430.79

A typical geometry project generated from a survey fieldbook will contain Cogo points for
each point surveyed. These Cogo points are indexed with the shot number recorded in the field
during collection. In addition to the Cogo points, horizontal and associated vertical alignments
are created for each linear feature surveyed in the field such as; edge of oil, ditch or stream
shots, or centerline shots. These alignments inherit their name from a combination of the
survey collection code and an incremental index number.
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Sample Right of Way Geometry Project

12345
ROW
Existing Proposed Existing COGO
Centerline Centerline RW_North Buffer
Existing Proposed Proposed Parcel AC-11
RW_South RW_North RW_South J.W.Wood

A typical Right of Way geometry project may contain only Cogo points and horizontal
alignments. The horizontal alignments may represent existing or proposed ROW limits,
easement limits, section lines, and parcels. A parcel is defined as an alignment that closes on
itself.

Section Summary:

e The Survey groups collects and stores a variety of terrain information as geometry. This
data can be useful when developing a design project.

e The hierarchy within an alg file is, from top down: Geometry Project, Horizontal
Alignment, Vertical Alignment

e The Cogo Buffer is on the same level as horizontal alignments in the hierarchy, but has no
children. However, cogo points contained in the buffer can be used to define a horizontal
alignment.

e The data created and stored in a geometry project may be different or have different uses
for each specialty group, but the hierarchy will remain the same.
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Geometry Terminology and Attributes

Section Objectives:

Describe the various type of geometry data.

Terminology of Geometry Data Types

Geometry Project - All geometry, whether it’s horizontal, vertical, or cogo points is stored
in a single digital container called a Geometry Project. To put it another way, individual
horizontal, vertical, or cogo points cannot be written to disk by themselves, only within a
geometry project. The same is true for loading data; only geometry projects can be loaded,
not individual alignments.

Cogo Point - Store the X, y, and z coordinate for a specific point. The information is in the
following format: name, X, y, and z

Horizontal Alignment - describes a horizontal path through the project
Vertical Alignment - describes a vertical path through the project

Geometry Styles - Geometry Styles are saved settings that can be assigned to a geometry
alignment or cogo point. The Geometry Style definition stores how the alignment or cogo
point will be displayed in the CAD file. Geometry Styles can be assigned to Points, Lines,
Arcs, and Spirals; each style will have settings for planimetrics and annotation display. The
Geometry Styles are defined in the Style Manager dialog box.

Style Manager — Overview

The Style Manager is used to create, edit, and delete the Geometry Styles for Points, Lines,
Arcs, and Spirals. The symbology is edited through the Named Symbology Manager which can
be accessed from the Style Manager. Because the styles for surface features, survey features,
and geometry are all stored in the xin file, the Style Manager Has filters to segregate the
different types of styles.
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e Seclect Tools > Style Manager

Geometry Point Symbology

Geometry Point Symbology is a saved setting for horizontal and vertical alignment keypoints
(vertices). Each vertex will be defined in the alignment as 1of 33 possible alignment keypoints
such as: POB, PC, PI, PT, TS, PVT, PVT, etc. Each Geometry Point can be saved as a point
Symbol Font or Cell definition depending on the annotation settings. Geometry point
symbology is stored in the xin file and is accessed through the Named Symbology Manager.

Section Summary:

e There are three types of geometry data in InRoads XM: Cogo Points, Horizontal
Alignments, and Vertical Alignments. InRoads 2004 also has Superelevation in the
geometry project.

e Geometry, surface feature, and survey styles are all stored in the xin file. Filters can be
used to isolate the geometry styles.

e Editing the xin file (through Style Manager or Named Symbology Manager) is only
temporary. The edited attributes will be changed back the next time you log into your
computer.

Geometry Management

Section Objectives:
e Discuss when it is appropriate to create unit specific geometry projects.

When the Survey/ROW group exports geometry from an InRoads Survey Fieldbook, the Geometry Style
assigned to the geometry element is based on the InRoads Feature Style assigned to the surveyed element. If
the associated Geometry Style is not found, the Style Default is used. After exporting, the user can change the
geometry style associated with existing geometry and apply appropriate symbology. This is true if working
with geometry generated from field survey information or from geometry created in the design process.

As standard procedure, CDOT may wish to direct each discipline to maintain independent geometry projects
for specific projects. By doing so, the various disciplines would be responsible for maintaining their data and
also be responsible for coordinating with other workgroups to ensure everyone is working with the correct
foundation geometry.

Possible scenarios:

e  When Survey exports the fieldbook to a geometry project it is stored in:
Drive:\JPC#AROW\InRoads\Geometry\ as JPC#FB2006 02 06 A.alg (FieldBook A dated
February 06, 2006 or otherwise named)

e Design may have use for selective items such as the centerline of road, fences, utilities, etc.
as alignments and/or Cogo points, but not need or want alignments and Cogo points for
every single observation taken in the field. For efficiency, not to mention segregation of
data, the roadway design discipline may wish to store the alignments they develop in:
Drive:\JPC#ADESIGN\InRoads\ as JPC#Design.alg (or otherwise named)

e Hydraulics or Traffic may desire alignments for drainage structures, waterways, or
pavement design or marking. There may be no need for Design or Survey to access this
data and vice versa.
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Segregating geometry by discipline specific geometry projects lessen the possibility of loss of data through the
regeneration of data. If the survey staff collects additional data or otherwise makes edits to the electronic
fieldbook, they will have to re-export (regenerate) the Geometry Project to provide current information. In
doing so, the possibility exists to over-write geometry created by other means.

Additionally, allowing individual disciplines the ability to create geometry as needed eliminates the task of
managing who has read/write access to a single ‘master’ geometry project and when access would be available.
However, it does raise the issue of communication. If the disciplines are dependent on geometry information
developed by others, it is imperative that down-stream users of that information are consulted and notified of
relevant changes.

Section Summary:

e Each specialty group should maintain there own geometry file for a specific project. This
reduces the possibility of data being changed or lost due to the actions of someone else.

e Maintaining separate geometry projects requires good communication between all groups
involved with the project so that no one is using inaccurate data.

Geometry Management Tools

Section Objectives:
e Describe how to set geometry active.
e Discuss the Copy, Delete, and Rename Geometry commands.

e Describe how to save geometry.

Setting Active Geometry

In order to use an alignment for commands like Tracking or placing MicroStation elements
with station/offset key ins, the desired alignment must be set active. The active geometry is
identified in the InRoads Explorer by a red box around the geometry’s icon.

Mt Bentley InRoads XM Edition
<Unnamed: -

Fle Suface Geometry Drainage Eval

__— Active Geometry Project

_~ Active Horizontal Alignment

i

T Active Vertical Alignment

&, Geometry g-@“b_rgference P P

File 'C:\P...\InRoads\12345_Design.alg' Ope

A geometry project or alignment can be set active by:
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1. Select Geometry > Active Geometry from the InRoads menu bar. This displays the

Active Geometry dialog box.

Mt Bentley InRoads XM Edition

<Unnamed:

= Geometn

Fits alignment ¢

& @ 3 Bt Alignment
£ De

TEE | ENY E w8

Fle Surface Qminage Evaluation Modeler Drafting Quartities ~

View Geometry * |Proj... Description
Design  SH 86 Design ...
Horizontal Curve Set 3
Vertical Curve Set 3
Horizontal Element 3
Vertical Element 3
Superelevation 3
Lot Layout 3

,_:? Review Horizontal...
[+2 Review Vertical ..
P Review Geometry Points...

Cogo Points v
Locate 3
T Traverse...

El Active Geometry...
=22 Lopy Geometry...
x Delete Geometry...
:lr BRename Geometry...

Litilities 3

2. 1In the Active Geometry dialog box, set the geometry Type using drop down menu.

3. Highlight the desired geometry from the list at the bottom of the dialog box.

4, <D> Apply to make the geometry active.

B A ctive Geometry =] & ==
Type: Geometry Project — + Apply
Description zometry Project

2 Horizontal Alignment
Vertical Alignment
Help

Cument
Geometry Project: 12345DES_Geometry
Horizontal Alignment:  SH 86
Vertical Alignment: SHEEV
Mame Description
Default

450 eometr 26 Design geometr

5. Reset the Type as needed to select different levels of geometry to set as active. <D> Close
to dismiss the Active Geometry dialog box when finished.

Geometry can also be set active by accessing the right click menu from the InRoads Explorer.

1. <D> the Geometry tab at the bottom of the InRoads Explorer.

2. <R> on the desired geometry.
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3. Select Set Active from the right click menu.

Mt Bentley InRoads XM Edition
<Unnamed> ~EBE | 8N B s 8| ket

Fle Suface Geometry Drainage Evaluation Modeler Drafting Quantities Tools |

=& Geometry Projects
= Default
| 12345 _Design

New...
Set Active

Copy...
Delete

= Geometry I@ Prefe Emety

TI'oggles Locate Features/Lo L=
s | —

#-[f] Side Road

Copy Geometry

Copy Geometry can be used to copy geometry from within the same geometry project, or
from project to project.

!_'1 Copy Geometry [E=R(E=R(E=<D
Projects | Horizontals I Verticals I Cogo Paints
From Apply
Geometry Project: 12345DES_Geometry
Help
Mame Description
Default

12345DES_Geom...5H 86 Design ge...

12345 5H115 SH... Ramp alignmerts ...

To
Geometry Project: 12345DES_Geometry
Description: SH 86 Design geometry
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Delete Geometry

Delete Geometry removes the selected geometry from the internal memory. If the
geometry project is then saved, the deleted data will be removed from the hard drive as well.
The Delete Contents Only toggle deletes the data but retains the placeholder within the

geometry project.

ﬁ Delete Geometry =] & ==

Type: [Geometry Project v] J [ Apply ]
Geometry Project
Horizortal Alignment
| Vertical Al m et |
Superelevation Help

Mame Description

Default

12345DE5_Geometr... SH 86 Design geome..

12345 SH115 5H52 |... Ramp alignments for ...

[ Delete Cortents Only

Rename Geometry

Rename Geometry is used to change the name of a geometry project or individual
alignment. It is also used to add/modify a description and change the style attached to the
selected geometry.

ﬁ Rename Geometry

From
Geometry Project:

Type: [ Horizortal Alignment

7

[12345DES_Geometry

7

Horizontal Alignment: SH g6 ﬂ
Mame Description Style
Off Ramp ALG_PRO
SH 86 5H 86 Centerine ALG_PRO
SHBE_Offset_Left CL For left driving surface ALG_PRO
SideRoad (500 501 502 ) ALG_SECONDA
4 | i b
To
Name: SH 86
Description: SH 86 Centerline
Style: ALG_EXISTING v

== [
Apply

Help
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Saving an Alignment

Alignments are not saved individually. Instead, they are saved when the geometry project is
saved. Since you are working on a copy of the geometry project that is loaded in memory,
saving is a good idea whenever you make changes to your alignment, and mandatory before
exiting — assuming you want to save your changes.

Geometry projects can be saved using several methods including:
Choose File > Save > Geometry Project

The active geometry project is saved.

M Bentley InRoads XM Edition =)=
<Unnamed> AT SN Hr v B R EE e
ﬁurfac:e Geometry Drainage Evaluation Modeler Drafting Quantities Tools Help
1 New... Ciri+N File Name By Whom

@n... Cir+0 A DeainrtA1 e
Save 4 Dp Project Cirl+P
§Y Save As... : : face CilS

Close 4 E, Geometry Project Cir+G
@ Project Defaults... Template Library Cirl+T

}z Text Import Wizard. .. H’ SRRy D rk:H

Right-click on the Geometry Project in the Explorer menu and chose Save

Mt Bentley InRoads XM Edition
<Unnamed:> MCEA AR Al Bl
Fle Suface Geometry Drainage Evaluation Modeler Drafting Quantiies Tools Help
MName Description By Whom
=& Geometry Projects % Cogo Buffer cferree
el S Off Ramp cferree
12345DES_Geometry || =
New...
| 5ave
Save As...
Set Active
Copy...
Close
Empty
% Surfaces| & Geometry [ 4
Saves the active geometry project s oizonlaE
View All Turnouts L

The geometry project you highlighted is saved.

If the geometry project has never been saved, either of the previous methods will bring up the
Save > As box shown below.
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Choose File>Save As

Mt Save As @
Save in: InRoads - & Y = T
= MName Date modified Type
Y | |12345DES_Geometry.alg 12/4/20097:21 AM  ALG File
RecentPlaces | 97345DES_Geometry_Overlay.alg 12/1/200910:00 AM  ALG File
! |_|12345DES_Geometry_Toes-Lab.alg 12/1/2009 10:00 AM  ALG File
|_|12345DES_Geometry-Islands.alg 12/1/2009 10:00 AM  ALG File
Desktop |_|12345DES_Median-Ditch.alg 12/1/2009 10:00 AM  ALG File
?]‘— "
CDOT User
Computer
- 4 M 3
LI
- File name: I Example] - I I Save I
MNetwork _
Save as type: |Geometr).r Projects ("alg) - | | Cancel |
Help
Active: | 2234505 _Geometry ~| [ optons... |

Set the Files of Type to (*.alg)

Choose the geometry project you want to save (in the Active category)
Key in the file name (or use the default)

Choose Save and the file is saved.

Note: Geometry projects have both an internal name that appears in the dialog boxes in
InRoads and a name on the hard drive that has an .alg extension. Care should be taken to make
certain you have chosen the correct geometry project name to match the file name you specify.
Otherwise, you could accidentally save over a file on the hard drive with the wrong geometry
project.

The geometry project may also be saved as part of the project file or .rwk, which you will be
using in your lab activity.

Section Summary:

e  When InRoads commands, other than Roadway Designer, reference geometry, they will
look at the active geometry only, unless the dialog box being used has an option to specify
other geometry.

e The Copy, Delete, and Rename Geometry commands wonk on whole geometry items only
(Geometry projects, horizontal alignments, or vertical alignments). The tools to edit
alignment components are discussed in the next chapter.

e Be careful when saving a geometry project, the name seen in InRoads does not have to be
the same as the one on the hard drive.

Viewing Horizontal Geometry

Section Objectives:

e Describe the methods to individual view horizontal alignments.
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e Describe how to view all of the horizontal alignments in a geometry project at once.
e Describe the View Stationing command.

e Describe the View Horizontal Annotation and Curve Set Annotation commands.

Horizontal geometry is used as a reference line for determining stations and offset distances in a set of design
plans. In InRoads, viewing a horizontal alignment places graphic elements representing that alignment into the
MicroStation dgn file. The various methods od displaying horizontal geometry information are described
below.

Viewing the Active Horizontal Alignment

To display the active horizontal alignment into the MicroStation dgn file:

1. Select Geometry > View Geometry > Active Horizontal from the InRoads menu
bar.

B4 Bentley InRoads XM Edition

<Unniamed> ~EE | S8NY B 58| sl ah
Fle Surface geometrylglainage Evaluation Modeler Drgfting Quartities Tools Help
View Geometry ’I 'ﬁ Active Horizontal
=& Geom =] Fit %mem —Eﬁ Active Eertic:al

P

= Horizontal Curve Set v| 2% Horizontal Annotation...
Vertical Curve Set 4 L?g Vertical Annotation...
. &) Closed Areas...
R 4 Stationing...
E 3D Alignment...

Horizonital Element
Vertical Element

Superelevation *| /% Station Base/Clearance Annotation...
Lot Layout b /_é_\ Curve Set Annotation...
“f¢ Vertical Change In Plan...
= Geometny, o . ; _-T_-_ =
~+ Review Horizontal... 3% Annotate Graphics...

Annotates grapl b2 Review Vertical...

e Review Geometry Points... ?ﬁ All Horizontals

An alignment can also be viewed (displayed) from the right click menu.
1. <D> the Geometry tab at the bottom of the InRoads Explorer.

2. <R> on the desired geometry.
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3.

Select View from the right click menu.

MNew...
Set Active
Copy...
Delete
Empty
| view
Fit
M Bentley InRoads XM L [E=R(ESR (<D
<Unnamed: Review.. » B s . [~ a5 1 L=l 5 uy.
Fle Suface Geometi Eh=lni=uivE Drafting Quantities Tools Help
Read-Only Type Description By Whom
B&. Geometry Pre /  Read-Write Superelevation Design optionl  CDOT User
: Default Details... Vertical Alignment cferree
=[] 12343DE5 ¢ - . Vertical Alignment SH 86 Vertical cferree
% CogoB v  Arc Definition

Off Ran

Chord Definition

C

[ _Offset_Left
[]---f SideRoad

= Geometryl@ Preference| « | » p

I

Toggles Pencil/Pen mode

Note: Using the right click menu to view an alignment also sets that alignment active.

Viewing All Of The Alignments In A Geometry Project

All of the alignment within a single geometry project can be displayed at one time. To view all
of the horizontal alignments in the active geometry project:

1.

Select Geometry > View Geometry > All Horizontals from the InRoads menu bar.

-

B4 Bentley InRoads XM Edition == ]E= ]
<Unnamed> ~ES 8NY B 5B e SRk
File  Surface § Geometry IQlainage Evaluation Modeler Drgfting Quartities Tools Help
\'iev:@eometry ’I 'ﬁ Active Horizontal ast Revised Al=
E= Fit Alignment [y Active Vertical /27,2000 6:37:... R
Horizontal Curve Set + | 2% Horizontal Annotation... /27/2009 6:27:... R|=
Vertical Curve Set 4 L?g Vertical Annotation... /27/2009 6:27:... R
Horizontal Element , % Gl /27/2009 6:28:... R
¥ Vetical Bement L | = ﬁtatloljlng... /27/2009 6:28:... R
: [27 2D Algnment... /12/2006 5:37:... R
; J: Superelevation *| /% Station Base/Clearance Annotation... /12/2006 5:37:... R
‘ | Lot Layout | =" Curve Set Annotation... /27/2009 6:29:... R
“J& Verical Change In Plan... i ommnn e _
&a Geometn ,_3 Review Horizontal... 3% Annotate Graphics... [
Displays the act & Review Vertical .. - -
2 Review Geometry Points... I?ﬁ All Horizontals

All of the alignments within a geometry project can also be viewed (displayed) from the right
click menu.

1.

<D> the Geometry tab at the bottom of the InRoads Explorer.

2. <R> on the desired geometry project.
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Select View All Horizontals from the right click menu.

M Bentley InRoads XM Edition = | 5]
<Unnamed:> FEE | 8NY B W B e R L
Fle Suface Geometry Drainage Evaluation Modeler Drafting Quartities Tools Help
MName Description By Whom Last Revised Acce
E‘% Geometry Projects “ | | %" Cogo Buffer cferree 12/4/2009 7:21:... Reac
:; el S Off Ramp cferree 3/19/2009 4:42:... Reac
SR 12345DES Geometry, s e 3/17/2009 212:... Reac
=i New... .
- ~0go BuTTer = 12/4/2009 7:18:... Reac
LT f24/. ...
Geometry < Save 11/24/2007190... Reac
Projects L - SHE6_Offset_Left Save As..
- S SideRoad Set Active
12345 5H119 SH52 In
‘e Cogo Buffer oy
/ Rarmp A-H Cloze
f Ramp B-H Empty
- f Ramp C-H
4 i 1 View All Horizontals
—
= Geometry I@ Preference View All Turnouts b
 —
Toggles the Feature Filter Lock View All Rails, Joints and Distance Keepers

Note: Using the right click menu to view all horizontal alignment sets the selected
geometry project active.

Displaying Stationing

To display the stationing of an alignment in the design file, select Geometry > View
Geometry > Stationing. There are several standard CDOT preferences to choose from,
depending upon the type of alignment you’re stationing as well as the station interval. Choose
the appropriate preference, then Apply to see the stationing. The Station lock, if on, will force
the display to even stations.

B View Stationing =] = |
Radius + A I Transition Radii I Event Pairts I ertical Stations |
Main | Regular Stations I Cardinal Stations I Pls I Station Equations |
Horizontal Alignment: [SHSB ']ﬂ [ Help ]
Limits
[ station
[ Planarize
Interval: 500,00 [T Drop Station Equation Name
Symbology:
Object Mame i
Z Major Ticks ALG_PRO_Sta-Major  BYL
Z Maijor Stations ALG_PRO_Sta-Major BYL =
Z Minor Ticks ALG_PRO_Sta-Minor  BYL
|| Minor Stations ALG_PRO_Sta-Minor  BYL
Z Cardinal Leader ALG_PRO_Cardinals  BYL
Z Cardinal Stations ALG_PRO_Cardinals  BYL
Z Pl Leader ALG_PRO_Cardinals  BYL
Z Pl Stations ALG_PRO_Cardinals  BYL
Z Equation Leader ALG_PRO_Cardinals BYL _
= - T
[ Apply ] [ Preferences... ] [ Close
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View Horizontal Annotation

Depending on the options selected, the user can define which alignments or Cogo points are
annotated. This dialog is accessed by selecting:

Geometry > View Geometry > Horizontal Annotation

Main Tab
E\l"iew Harizontal Annotation =] & ==
Main | Tabling | Styles
Apply Style Fitter
@ Assigned ) Active Crverwrite
- Help
Horizontal Alignments Cogo Points
Include: sH g6 ﬂ Include: ﬂ
Selected: Selected:
Mame Descri..  Style Mame Descri..  Style
SH 86 SH86Ce..ALG_P...
Display As Complex Linestring
Display Annotate
Points [ Points
On-Alignmert [ Event Points Elements
[T Off-Mlignment [ Station Equations [ Duplicates
Elements [C] Dual Dimensions
[ Radials [ Tangents Try Atemate Styles
[T Chords [ Subtangents [7] Bxtend Beyond Element
[ Planarize
[ Apply ] I Interactive I I Preferences... I I Close I

Apply Style - This section is used to determine the style used for the annotation.
¢ Assigned - This option uses the geometry style assigned to the alignment or cogo point.
¢ Active - This option uses the styles selected in the drop down menus in this section.

¢ Override - If the Active option is selected, selecting Override will use styles selected in
the drop down menus in this section. In addition, the style assigned to the geometry
element is changed to the active style.

Horizontal Alignments - This area is used to select the alignment(s) to be annotated.

¢ The Include field is used to specify the desired alignment(s). Wildcards can be used to
select multiple alignments. An alignment can be selected graphically using the target

ﬂ button.

¢ Display as Complex Linestring - When on, the alignment is displayed as a complex
linestring (a single graphic element). When off, each element of the alignment is a
separate graphic element, though they are part of the same graphic group.

Cogo Points - This area is used to select the cogo points to be annotated.
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¢ The Include field is used to specify the desired cogo points. Wildcards and point
ranges can be used to select multiple points. A cogo point can be selected graphically

using the target ﬂ button.

Selected - These areas show the items that will be annotated. Alignments and cogo points can
be annotated at the same time

Display - This area is used to specify the types of points and alignment elements to be
displayed.

¢ Points - When toggled on, the points symbols for the indicated point types are
displayed.
o On-Alignment - POB, POE, PC, and PT are examples of on-alignment points.
o Off-Alignment - PI, and CC are examples of off-alignment points.
o Event Points - These are “stations of interest” that the user adds to the alignment.

o Station Equations - These alter the normal stationing of the alignment, usually to
match that of another alignment.

¢ Elements - When toggled on, the indicated alignment elements are displayed.
o Radials - Lines from the center of curve (CC) to the PC and PT.
o Chords - A line from the PC to the PT.

o Tangents - This is the line from the PC or PT to the PI. For a compound or spiral
curve it is from the PC or PT on the end curve to the PI on the main curve.

o Subtangents - This is the line from the PC or PT to the PI. IT is displayed for each
curve element in a compound curve.

Annotate - This section is used to identify what geometry element types will be annotated and
how it will look.

Points - Text on/off for alignment keypoints or Cogo points
Elements - Text on/off for Bearing & Distance annotation

Dual Dimension - Imperial and Metric annotation

Try Alternate Styles - On/off for using alternate geometry styles

* & & o o

Extend Beyond Element - The annotation is placed even if it does not fit within
the extents of the element. This applies only to lines and circular arcs and to
annotation placed along the element.
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Tabling Tab

E View Horizontal Annotation

Main | Tabling | Styles

Table Corterts:  ©) None

Element Naming

[ Add All Elemerts to a Single Table
Prefix

Lines: L

Arcs: C

Spirals: 5

[ Display in Cell

ALG_EXISTING

[ Omit Element Naming

(@) Basic Element Information

() All Element Information

Seed Number

o o &

[ Apply ] [ Interactive

] [ Preferences...

J

Close

]

The CDOT configuration is not set up to use tabling, so this tab is not described.
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Styles Tab
E View Horizontal Annotation =] & ==
Main |Tab|ing Styles
Help
Point
Style Style
e [mwoerm o] PO
TS [1s ~| POE: POE -
5T: T -
SPI: 5Pl -
Element
Style Style
[¥] Mlignment’s Style Ovemides Point’s Style
[¥] Alignment’s Style Ovemides Blement's Style
[ Apply ] [ Interactive ] [ Preferences... ] [ Close ]

The Styles tab is used to specify the display properties of geometry points and elements. The
styles specified here are used to display all point symbols, and if specified, for element and

annotation styles as well.

Point Section - This area is used to specify the style used for the following geometry points:

PC - point of curvature
PI - point of intersection

CC - center of curvature

PT - point of tangency
TS - tangent to spiral
SC - spiral to curve
CS - curve to spiral

Event Points

SPI - spiral point of intersection
PCC - point of compound curvature
PRC - point of reverse curvature

SS - spiral spiral

POB - point of beginning

POE - point of ending

ST - spiral to tangent

Station Equations

Element Section - This area is used to specify the style used for the following geometry

element types:
Radials Cords

Tangents

Subtangents

Colorado Department of Transportation
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Alignment's Style Overrides Point's Style - When selected, the annotation text of points is
displayed using the alignments style. The point symbol uses the style specified above. When
toggled off, the style specified above is used for both the point symbol and the annotation.

Alignment's Style Overrides Element's Style - when selected, geometry elements are
displayed with the alignment's style. When toggled off, they are displayed with the
style specified above.

Curve Set Annotation

Annotating horizontal alignments to the CDOT standard is a two step process covered in the
CDOT Annotating Horizontal and Vertical Alignments workflow. The process uses the
Horizontal Annotation command described above to annotate the linear geometry segments.
Curve Set Annotation is used to annotate circular and spiral curves.

To annotate the curves on an alignment, select Geometry > View Geometry > Curve Set
Annotation from the InRoads menu bar.

B4 Bentley InRoads XM Edition o= [ B ER
<Unnamed> FESE 8N (EX %8 [ EE e
Fle Surface mgﬁlinage Evaluation Modeler Drafting Quantities Tools Help
View Geometry ’I'ﬁ Active Horizontal By Whom

-2 Geom £ Fit ﬂgnmerﬁ

Horizontal Curve Set
Vertical Curve Set

[y Active Vertical

v | 3% Horizontal Annotation...
v [2% Vertical Annotation...

CDOT User
cferree
cferree

Horizontal Element » % C_Jos.ed.Areas___
Vertical Element , | = Stationing...
E 3D Alignment...
U EEEi ' - Station Base/Clearance Annotation...
—

Lot Layout

; ‘x: ,_3 Review Horizontal...
+f & Review Vertical...
f b Review Geometry Poirts...
Il
|

2 Al Horizortals

Cogo Points 3

Locate 4
Geomet _
= 2 o Traverse... il L

Displays the nar closed alignment

E-l Active Geometry...

Main Tab
Settings on the Main tab are used to specify what part of the alignment is annotated.

e Station Limits - Determines where along the alignment that annotation will occur. When
toggled off, the whole alignment is annotated. When on, only curves within the station
extents are annotated.

e Annotate Each Element of Curve Set - When on, each part of a compound curve is
annotated as a separate entity. When off a compound curve is annotated with one set of
curve data for the whole curve set.

e Drop Station Equation Name - Station equations have an alpha(letter) component to the
station. When this toggle is on, the alpha component of the station is dropped from the
annotation display.

e Symbology - This area is used to choose the annotation elements that are displayed.

¢ Text - When on, the text for the items selected on the advanced tab is displayed.
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¢ Tangents - When on, a short section of the tangent line is displayed, extending from
the PL.

¢ PI1 Symbol - When on, the CDOT PI symbol is placed in the proper location.

HCuweSetAnnotation =] & ==
Main | Advanced
Horizortal Alignment: |5 gg - ﬂ Help
Limits
Station

Annotate Each Element of Curve Set

Drop Station Equation Name

Symbology:

Object Mame
[ Text BYL
[ Tangents ALG_PRO_Tangents  BYL
E Pl Symbol ALG_PRO_Tangents BYL

[ Apply ] | Preferences... | | Close

Advanced tab

The advanced tab is used to specify what information is included in the annotation. The toggle
headings describe what will be annotated. The columns preform the following functions:

Column - This determines the position of the annotation. 1 is the left most column moving
to the right as the numbers increase. These are not absolute column numbers, however.
They indicate the order in which the data is placed when two or more items occupy the
same row.

Row - With the Column entry, this determines the position of the annotation. 1 is the
topmost row moving to the down as the numbers increase. These are not absolute row
numbers, however. They indicate the order in which the data is placed when two or more
items occupy the same column.

Prefix - this is text added to the front of the data.
Suffix - this is data added to the end of the data.
Precision - This determines the number of decimal places displayed for the data.

Format - Specifies the style that station and slope data is displayed.

Note: columns are separated by a single space. Therefore, additional editing may be
required to make the annotation more readable if multiple columns are used.
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Section Summary:

e Annotating an alignment to the CDOT standard is a two step process. Refer to the, “CDOT
Annotating Horizontal and Vertical Alignments” workflow for details on this process.

e Point Symbology for horizontal annotation is taken from the Styles tab and not the
alignment.

Reviewing Geometry

The data within a geometry project can be accessed in ways other than by displaying it to MicroStation. The
most common is Review Geometry.

Activating the Review Geometry Command

To review a horizontal alignment select Geometry > Review Horizontal from the InRoads

menu bar.

H Review Horizontal Alignment = | 5]
Geometry Project: 12345DES Geometi v Mode Close
Horizontal Alignment: SHSE% ﬂ Cunve e © Alsnment Semert

’ b Save fs...
Project Hame: 12345DES Geometry - Append...
Description: SH 86 Design geometry I—I
Horizontal Alignment Name: SH 86 = Displ
Description: SH 86 Centerline Iﬂl
Style: ALG_PRO .
STATION HORTHING EASTING IPn—ntI
Element: Circular sl
PC 3 203+80.28 1556706.07 3277567 .49
PI ) 203+83.79 1556705 .14 3277570.88
cCoq ) 1527759 .88 3269685.99 S
PT 3 203+87 .30 1556704 .22 3277574 .27
Radius: 30000.00
Delta: 0700'48" Right
Degree of Curvature(Arc): o"11'z2a" < Pr
Length: 7.02
Tangent : 3.51 o
Chord: 7.02 =
Middle Ordinate: 0.00 -
4 f”.--‘- B - 13

The Review Horizontal Alignment dialog box can also be displayed by right clicking on the
alignment in the InRoads explorer or information panels and selecting Review from the menu.

B Bentley InRoads XM Edit. Edit... | [E=H | Eo|ExT)
<Unnamed: I Review... W |
] ey 4 | L& Check Integrity...
File Suface Geometry | Read-Only sfting Quartities Tools Help
v | Read-Write Type Descriptior

#-[£ Default Details... Superelevation Design opt
12345DES_Geoi

% Cogo Buff§ v  Arc Definition

Off Ramp Chord Definition

Vertical Alignment
Vertical Alignment SH 86 Verti

=2 Geometry |@ Preference| « | » p = :

Toggles the Style Lock
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Once the Review Horizontal Alignment dialog box is displayed, different alignments can be
selected for review. Use the Geometry Project and Horizontal Alignment drop down menus to

select the desired alignments.

H Review Horizontal Alignment

(===

Close

Save As...

Geometry Project: 12345DES Geomet v Mode
Horizortal Alignmert: [ g = ﬂ Curve Sets ‘@ Alignment Element
Project Hame: 12345DES Geometry
Description: SH 86 Design geometry
Horizontal Alignment Hame: SH 86
Description: SH 86 Centerline
Style: ALG_PRO
STATION HORTHING
Element: Circular
PC 3 203+80.28 1556706.07
PI ) 203+83.79 1556705 .14
cCoq ) 1527759 .88
PT 3 203+87 .30 1556704 .22
Radius 30000.00
Delta: 0700'48" Right
Degree of Curvature(Arc): o"11'z2a"
Length: 7.02
Tangent : 3.51
Chord: 7.02
Middle Ordinate: 0.00
4 m

EASTING

3277567 .49
3277570.88
3269685.99
327757427

»

m

Append...
Display

Print

[ savess.. |
( Append... |
[ Dsplay |
[ Pt |
[ hee |

Help

Alignments can be viewed in one of three different Modes. The most commonly used mode is
Alignment, which displays all of the data in one window. The other two modes are Curve Sets

and Element. Examples of each mode are shown below:

Alignment Mode:

H Review Horizontal Alignment

Geometry Project: 12345DE5_Geomet + Mode

Horizortal Alignment: S}-{Sﬁiv ﬂ Curve Sets ‘@ Alignment Element

(===

Project Hame: 12345DES Geometry
Description: SH 86 Design geometry
Horizontal Alignment Hame: SH 86
Description: SH 86 Centerline
Style: ALG_PRO
STATION HORTHING
Element: Circular
PC 3 203+80.28 1556706.07
PI ) 203+83.79 1556705 .14
cCoq ) 1527759 .88
PT 3 203+87 .30 1556704 .22
Radius: 30000.00
Delta: 0700'48" Right
Degree of Curvature(Arc): o"11'z2a"
Length: 7.02
Tangent : 3.51
Chord: 7.02
Middle Ordinate: 0.00
External: 0.00
Tangent Direction: S 74746'07" E
Radial Direction: S 15713'53" W
Chord Direction: S 74745'43" E
Radial Direction: S 1571441 W
Tangent Direction: S 74745'19" E
Element: Linear
PT 3 203+87 .30 1556704 .22
PC | 3 231475.30 1555971 .14
Tangent Direction: S 74745'19" E
Tangent Length: 2788.00
4 m

EASTING

3277567 .49
3277570.88
3269685.99
327757427

327757427
3280264 .16

»

Print
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Curve Sets Mode:

H Review Horizontal Alignment = | 5]
Geometry Project: 12345DES Geometi v Mode Close
Horizontal Alignment: SHSE% ﬂ © Cuve e Flonment Semert

’ b Save fs...
Project Hame: 12345DES Geometry - Append..
Description: SH 86 Design geometry L_______J
Horizontal Alignment Name: SH 86 Displ
Description: SH 86 Centerline L——EEEE—J
Style: ALG_PRO Print
STATION HORTHING EASTING
Curve Set Type: Circular = Hel
PI 3 203+83.79 155670514 3277570.88 2
PC ) 203+80.28 1556706.07 3277567 .49
cCoq ) 1527759 .88 3269685.99
PT 3 203+87 .30 1556704 .22 3277574 .27 Sele
Total Central Angle: 0°00'43" Right First
First Subtangent Distance: 3.51
Second Subtangent Distance: 3.51 T
External: 0.00
Radius: 30000, 00 =
Delta: 0~o0' 48" ast
Length: 7.02 —
Degree of Curvature(Arc): o"11'z2a"
Tangent : 3.51
Chord: 7.02
Middle Ordinate: 0.00
External: 0.00
Curve Set Type: Circular
P 3 233+25.05 1555931 .76 3280408 .64
PC ) 231475.30 1555971 .14 3280264 .16
cCoq ) 1557032 .43 3280553.39
PT 3 234472.97 1555932 44 3280558 .39
Fl nm 3
Element Mode:

H Review Horizontal Alignment El@
Geometry Project: | 12345DES_Geomet v Mode Close
Horizortal Alignment: 7SH36 = ﬂ Curve Sets Alignment @ Element [

: h Save As...
STATION HORTHING EASTING Append..
Element: Circular L_______J
PC 3 231475.30 1555971 .14 3280264 .16 Di
PT ¢ ) 23342505 1555931 .76 328040864 [ Depley ]
cCoq ) 1557032 .43 3280553.39 Print
PT 3 234472.97 1555932 44 3280558 .39
Radius: 1100.00
Delta. 15730°17" Left [ e |
Degree of Curvature(Arc): 51231
Length: 297 .67 I
Tangent : 149 .75 Select
Chord: 296 .76 E—
Middle Ordinate: 10.05 First
External: 10.15
Tangent Direction: S 74745'19" E < Previ
Radial Direction’ S 15°14'41" W lashmenn]
Chord Direction: S 82730'28" E N
Radial Direction: S 0715'3g" E
Tangent Direction: N 89744'24" E —
Fl nm 3
Note: The Element Mode activates the navigation buttons on the right side of the dialog box.

These are used to select different alignment elements for viewing.
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Section Summary:
e Use Review Geometry to become familiar with the different alignments in the project.

e  When using the Element Mode, the alignment element represented by the data in the dialog
box is also highlighted in the MicroStation view window.

Tracking

Tracking is used to obtain location information about MicroStation elements in relation to the active horizontal
alignment.

Section Objectives:

e Describe general Tracking.

e Describe Horizontal Alignment Tracking.

There are two methods of tracking a horizontal alignment.

Tools > Tracking > Tracking — Tracks both the active horizontal alignment and the active
surface. After applying the command, data point a location in the design file and the requested
information is displayed graphically. The listed elevation is read from the surface at the cursor
location, not at the alignment.

H Tracking (=3
MNorthing: N=1556550.78
Easting: E=3277543.35 -
Elevation: Blev=6630.27 %
Slope: Slp=1.36%

Aspect: A154™ ILI
Station: Sta=203+87.30

Offset: Off=117.58"

Dual Dimension: (35.84)

Settings

The Settings button is used to display the Tracking Symbology dialog box. It is used to turn on
or off the data types displayed in the Tracking dialog box. It is also used to define the
symbology for tracking data displayed in the MicroStation dgn file.

H Tracking Symbology (=3
|Objec,1 |COIumn |R0w |Preﬁx |Suf'fix |Prec:isi0n Name | |
[ Point I B —
[ Text InRoads_Misc | ... Preferences...
[ Northing 1 1 N= 0.12 b |
[ Easting 1 2 E= 0.12
[ Elevation 1 3 Elev= 0.12
[ Slope 1 4 Slp 0.12
[ Aspect 1 5 A 0
[ Station 1 6 Sta= 0.12
[ Left Offset 1 7 Off= " 0.12
Right Offset COff= :
[ Dual Dimension |2 7 { ) 0.12
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Displaying Tracking Data
To display the data in the Tracking dialog box to the MicroStation dgn file, <D> on the desired
location. To select an exact point on a graphic element, <T> to the desired point then <D>.

; b == S TE —— =i -
_‘éIL g C_llin' LR B Tracking [==]
) &J 55 oMo 0n Northing: N=1555900.27
NG 5F S | s
O‘j ()\I' @ evaton: eV= A a
:} K N oOC} (] Slope: Slp=18.66%
N N Aspect: A1g” Hep
Letp ~N Gy N Station: Sta=233+14.45
\{9 ISI Offset: Off=43.28'
Dual Dimension: (13.19)

Tools > Tracking > Horizontal Alignment — Tracks the horizontal alignment with a
perpendicular line to your cursor. Gives a Station, Offset, Elevation readout in the message
field, where the elevation is read from the active vertical alignment at the given station, not

from the DTM.

X

I

17, % B

NER-
1 e e |

"Station: 209+54.27 Offset: 23.88 Blevation: 0.00 Radius: 0.00"

/ @% 2 XA

oF | @

If a second horizontal alignment is selected, the offset will be between the two alignments,
perpendicular to the first.

Section Summary:
Both tracking options report stations relative to the active alignment.

[ ]

e General Tracking gives elevation data based on the active surface, Horizontal Alignment
Tracking gives elevation data based on the active Vertical Alignment.

e General Tracking data can be displayed into the MicroStation dgn file.

Colorado Department of Transportation
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Chapter Summary:

e The Geometry Project contains Horizontal Alignments, Vertical Alignments, and Cogo
Points.

e  Multiple geometry projects can be loaded at one time, but only the active project will be
accessed by the program when executing a command.

e Geometry Styles are stored in the CDOT _Civil.xin file along with Survey and Surface
styles. Changes to the styles should be requested through the CADD Manager’s office.

e The Copy, Rename, and Delete Geometry commands work on geometry projects and
horizontal and vertical alignments as a whole. To learn about modifying alignment
clements, see Defining Horizontal Alignments.

e Viewing geometry writes the data graphically into the MicroStation dgn file.
e Viewing annotation writes text data about the alignment into the MicroStation dgn file.

e The review geometry command displays alignment data in a dialog box. The data in the
dialog box can be written to a text file.

e Tracking is used to identify station locations of items displayed in the MicroStation dgn
file. With general Tracking, the data can be written into the dgn file.
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